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# Modification from previous version 

1.1 Extension of the explanation to the ZYZ/RPY angles, coupling matrix, SCARA 
kinematics and GUI interface, CodeSys installation and First Launch. 

1.2 Added VISION configuration description for IFM cameras 

1.3 Added CNC profile description (F.Franceschelli) 

1.4 Added FileZilla manual to explain how to get access to the Controller files. 

1.5 Added Update management system (F.Franceschelli) 

1.6 Added camera calibration, Vision system parameters setup and Vision PLC FB 

1.7 Added Auxiliary Axes use instructions 

1.8 Added Match Threshold computation instructions 

2.0 Content update 
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Aim of the document 

Manual for the User of the Robotic Controller that explain how to setup the software, configure 
robots and axis, use the Graphical User Interface and CNC interpreter. 
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 1.Controller initialization 

 1.1.Connection to the Robotic Controller 

Software needed: FileZilla (https://filezilla-project.org/download.php?type=client) or 
equivalent FTP client. 

In order to use correctly the device, it must be connected with Ethernet cable both to the PC and 
to the robot controller LAN1. 

After that, launch the FileZilla application on your PC to download all the files needed from the 
device to the pc 

.  

Figure 1:FTP connection 

Once FileZilla has opened, click on the connection configuration as showed in the Figure 1.After 
that, a new window will appear. The user must fill each field with the following indication. 

-Host address and port number: type the device address (192.168.80.240 in the example) 
and “22” respectively. 
-Connection protocol: click on the arrow on the right and select “SFTP” from the menu. 
-Username: “sftp” 
- Password: “sftp” 

And then, click on “Connect”. Now the user should be able to see in the right part of the screen the 
folders and the files contained in the device. 

Using FileZilla, ALL these files must be transferred to the user local PC (for example into a new 
folder) as showed in Figure 2. In this example, a new folder (“example”) has been created on the 
desktop of the local PC, has showed in the bar on the left part of the transfer window 
(C:\Users\scramp\Desktop\example). 

https://filezilla-project.org/download.php?type=client
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Figure 2: Transfer data form device to PC 

From now on, the user can access to all the device's configuration files, as showed in this 
document. 

Please note that the folder “Interface” contains the Graphical User Interface (GUI): its use will be 
described later on this document. 

 1.2.Introduction and general overview 

The Robotic Controller is structured to be a general platform to handle the actuation and the 
control of drives and group of drives (robots, automatic machineries…). To serve that purpose, the 
controller can be used with the Graphical User Interface on a host PC (not local on the embedded 
PC) or via CodeSys as platform for PLC programs. 

The User takes access to the controller, the folders contains the needed files to use the device. 

Folder Description 

Cnc That folder contains the files composing the programs of the CNC executor. 

Data Contains a text file (*.txt) composed of the LOG of the controller (the prints, 
messages of the controller during execution, that can be also visualizes connecting 
a VGA monitor to the controller) 

Interface Contains the ARC_Gui.exe file (Graphical User Interface executable file) needed to 
launch and use the GUI to command the controller. 

Plc Contains the bonmetLibrary.library file and the bonmet_controller.devdesc.xml file to 
configure correctly the CodeSys repositories. 

Config Contains the three configuration files: MOTION, ECAT and VISION that must be 
formatted in the name as “XXX_Config.xml” using instead XXX one of the three 
nomenclature of what the file must configure (MOTION, ECAT, VISION), the user 
must sent here its own configuration files with the name explained before. If one file 
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is missing the controller cannot be configure correctly so, for example, if the VISION 
modulo isn’t needed, an empty configuration file for the Vision part must anyway 
provide. 

Others 
files 

Readme.txt file contain the information here reported on the structure of the Robotic 
Controller; 

Release.txt reports information about the release of the runtime of the controller and 
about the GUI release. 

 1.3.Device Update 

The device’s software can be updated with new packages using the GUI as well. If the device 
must be updated, open the GUI without connecting to the device and click on Option → Update 
device as showed in Figure 3. If the user is already connected to the device, just click on the 
“Disconnect” button on the top-left corner of the GUI and follow the above instructions. 

 

Figure 3: update device 

After clicking on this option, the windows showed in Figure 4 will appear. 

First of all, check the target device by clicking on the “Check target” button on the first row: the 
target IP address should appear in the corresponding box. 

After that, select the software package to be updated by clicking on the “Browse package” button 
on the second row: the package name should appear in the corresponding box. 

If these two operations have been done correctly, the two check symbols will be green. If the user 
finds different symbols, check if the selected device and software package are the correct one. 

 

Figure 4: update condiguration 
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In the bottom part of the window, information about the software versions are displayed. The first 
three numbers are related to the software that is currently running on the device, while the second 
three numbers refer to the software to be updated. 

If the information are correct, click on the “UPDATE_TARGET” button in the center of the window 
to update the device. 

Once the update has finished, the information about the two software must be the same. 

 1.4.Configure Network 

To correctly configure the network (IP address, Mask and EtherCAT addresses) it is possible to 
operate from the GUI, in the main SR profile and change the parameters that the User wants to 
edit. 

 

Figure 5: Network configuration 

Once configured all the parameters, the User can press the “Ok” button and starts to use the 
Robotic Controller. 

 1.5.Download data to the Controller 

To setup the Configuration files needed to initialize the Robotic Controller, it is possible from the 
GUI (Graphical User Interface) to change them, localizing the file on the computer that host the 
GUI, load them, open to check if everything is correct and save that files in the controller. 

 

Figure 6:load configuration files via GUI 
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Localize in the SR profile of the GUI (to see deeper explanation regarding Graphical User 
Interface, see Chapter 5) the button to open the wizard to “Load New Configuration Files”. 

After press the “Load New Configuration Files” button, a wizard opens and allow the User to 
choose the files to be loaded and used as default Configuration inside the controller and also so 
open them and see them. 

Each Configuration file (ECAT, MOTION, HAND and VISION) must be loaded. 

Once the files have been selected, they can be opened in the GUI wizard to check if everything is 
ok and after that, with “DONE” command they can be stored inside the Controller: 

 

Figure 7: View file using GUI 

After the Configuration files have been loaded correctly, to see them work the Controller must be 
rebooted, using the devoted procedure: push the “Reboot Device” button and press “YES” 

 1.6.CodeSys setup 

To creates a PLC program and use the blocks of the ArcaLibrary in order to create applications 
and motion profile for the robots and in general for drives, it is necessary to install CodeSys PLC 
programming environment and configure the connection with the Robot Controller. 

First the User needs to install CodeSys on the host PC used to control the embedded controller, 
following the procedure: 

• Launch “Setup_CODESYSV35SP8.exe” to start the installation wizard of the application; 

• Follow installer instructions, using STANDARD setting and usage. 

After the installation of the software utilities, the User must install the Controller device inside the 
Device Repository and the ArcaLibrary with all the blocks to use the controller, inside the Library 
Repository, following the procedure: 

• Launch CodeSys v3.5.8.1; 
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Figure 8: add device files 

• Select in the tool bar the menu “Tools -> Device Repository” and click on “INSTALL”, select the 
file “ARC_Controller.devdesc.xml” on the User’s PC, and the ARC Controller object will be 
added in the repository. After adding the repository, exit by clicking “DONE”.  

• To install the library inside the devoted repository, in the menu bar select “Tools -> Library 
Repository”, click on install and select the file “ArcaLibrary_compiled-library”. 

• Once the procedure of adding the library is done, click again on “CLOSE” to exit. 

 

Figure 9:add library files 

Please pay attention to the library adding procedure: if the User wants to open a project and needs 
to update the ArcaLibrary release, could be necessary to repeat the procedure of repository install 
deleting before the old installation, as reported in the further steps: 
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Figure 10: delete the old installation and add a new library 

• Under the project open, browse to find “Library Manager” and check the open windows on the 
right: select ArcaLibrary installed and click on “Delete Library”. 

• After deleted ArcaLibrary, click on “Add Library” and on the opened library, click on 
“Advanced...” 

• Open the Library Repository and browse to find in the host PC the ArcaLibrary.library that the 
User wants to install and select it. 

After adding the new library, it must be visible in the “Library Repository” window. Once done that 
procedure, close all the windows and re-click the “Add Library” button to open the adding 
procedure, now click on “Miscellaneous” and select the Arca Motion Library the User wants to use 
(the installed one). 

Once the library has been installed, on the menu bar, select “Build” and a menu window will open, 
click on “Clean All” and “Yes” on the pop-up window that appears. After that, click on “Build” 
command and CodeSys will compile all the project. 

If no errors occurred, the User can now launch the project as will be explain in the next Section. 

 

Figure 11: Build the new project 

 



 

8 

 

 1.7.First application running 

To launch the first application follows the instructions in CodeSys, after the setup of the 
repositories: 

• Select “File -> Open Project” and open project file “GIPPER+APP.project”; 

• Select “Build -> Rebuild all” (if some problems arises with the library follow the steps for delete 
and re-add the library explained in the previous Section). 

 

Figure 12: connect the device via PLC 

• Select node “Device (Codesys_Control*86…)” -> right click -> Edit Object, the device 
connection window will be opened and appear like the one reported below. 

• Click on Scan network to search the controller. if controller is recognized, the GREEN light will 
be turned on, otherwise an error message “No device is responding to the scan request” will 
be shown: in this case check controller settings and cabling. 

• Double click on “MAIN (PRG)” to open the main project page. 

• Select “Online -> Login”: the environment will compile project, download to the target and 
change the view into online mode. 

On the variable list, in “PREPARED VALUE” column, double click in the “POWER” variable row 
and CodeSys made appear a blue box “TRUE”. 

 

Figure 13: start the project by writing boolean value 



 

9 

 

• Write value to controller selecting “Debug -> Write values” (or pressing CTRL+F7). The robot 
will switch on (notice the change of variable “Powered”). 

• Change value of variable “enb” and “startMov” in TRUE and write it to controller, the robot will 
starts doing a Pick And Place test movement. 

(Example of the CodeSys execution window where it is possible to change values of variables) 

 1.8.Variable trace in CodeSys 

When running a CodeSys application, it is possible to trace the used variables in order to have a 
better understanding about how they are evolving. Traces can be easily configured as additional 
objects inside the application. 

 a)1.8.1 Trace Configuration 

After opening the CodeSys application, right click on the left tree menu on “Application”. Select 
“Add object”--> Trace, as showed in Figure 14. 

 

Figure 14: add trace in PLC 

Select the name of the trace and click “Ok”. Select the created trace and open the Trace 
Configuration. In the new window select the task to be associated to the trace as showed in Figure 
15 

 

Figure 15: set Trigger and task configuration 

After selecting the task, there are many other options that can be selected. The trigger 
configuration could be very useful to detect a particular condition when running the application: it is 
possible to select a variable to be associated to the trigger, the edge of detection (positive, 
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negative or both), a number of samples to be recorded after the trigger detection and also a 
Trigger level.  

In the example above, a trigger has been associated to the boolean variable Main.enb of the main 
program. The trigger will be detected when this variable will turn both from FALSE to TRUE and 
inverse (both) and it will record 20 samples after the trigger detection.  

Once the general configuration has been done, the user can proceed to add the variables to be 
traced. Click on “Add variable”.(Figure 16).  

 

Figure 16: add variable into trace 

First of all select in the corresponding field the variable to be traced.  

After that, many graphical options could be selected, like colors, line type, point type for each 
sample and critical limits.  

In the example above, the variable AxisPosition0 and AxisPosition1 of the main program will be 
traced. The graph color will be blue and green, and each sample will be visualized as a dot linked 
to the other through a line. Otherwise user can also activate the limitation warning.  

Please remark that not all the PLC program variables can be plotted in a trace: for example, the 
element of an array can not be plotted. If the user find himself unable to plot a variable, try to 
create a new global variable inside the PLC program, assign the value of the old variable to the 
new one, and try to plot the new variable.   

Example: let’s suppose that the positions of a robot have been stored inside the PLC program into 
an array Robot_Positions=[Pos_X, Pos_y, Pos_Z, Rot_A, Rot_B, Rot_C]. In this way the robot 
positions can not be plotted in a trace… But, if the user assigns the positions to a new variable 
outside the array, it is possible to trace the new variable.   

Position_X : REAL;  

Position_X := Robot_Positions[0];  

The new variable Position_X can be plotted inside the trace!  

 b)1.8.2 Trace Visualization 

Once the trace has been configured, run the PLC application. Open the created trace, right click 
on the graph and select “Download trace”. In this way the traced variables will be updated while 
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the application is running. In Figure 17 are showed the traced variables configured in the example 
above.  

 

Figure 17:Download the trace example 

As can been seen, the detected variable will be illustrated in the above two windows. Once the 
trace has been done, there are many options that can be used. By right clicking on the trace, it is 
possible to add a cursor, in order to scroll the values of each traced variable. 

It is also possible to save the trace in both .trace and .txt format, or load a previously saved trace 
(right click on the trace and select “Save Trace” or “Load Trace”). 
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 2.Graphical User Interface – GUI 

 2.1.Introduction 

The Scramp robot can be controlled both with a graphical user interface (GUI) and with a PLC 
control. The first type of control is suitable to test some movements or configuration of the robot, 
as well as testing if the drivers are working correctly. The second type of control is used in order to 
run a PLC program written as a CodeSys file. 

Once the connection is ready, connect to the controller by pressing “Ctrl+C” buttons or following 
the path “File->Connect”. 

 2.2.GUI aspect 

The main page of the Scramp robotic controller is showed in Figure. On the left part of the window 
there is a tree selector, which allows you to interact to the different part of the device: SR, AXIS, 
GROUP, CAMERAS or CNC. 

 

Figure 18: Main window of GUI 

By selecting SR, we can set the Controller Authority between GUI/CNC or PLC program. 

With the second option it's possible to run a PLC program written in the CodeSys environment, 
while the first is used to interact with the robot by using the commands of the GUI (described later 
in this documents). 

Please note that this two options are mutually exclusive: once selected the GUI/CNC Controller 
Authority it won't be possible to run a PLC program, while if the PLC Program is selected, the GUI 
commands will be not available. 

Every time there is a change between these two Authority a password will be requested in order to 
accomplish the change. In the development phase, these two passwords are “GUI” (if you want to 
change the Authority from PLC to GUI) and “PLC” (if you want to change the Authority from GUI to 
PLC). 

Below the Controller Authority there are the “Config files”, “Change Network Configuration” and the 
“Reboot device” buttons, which are shown in chapter  1.4and  1.5. 

Below the described buttons, you can find information about the current release, the used 
configuration (.xml) files and the objects that describe the robot arrangement (number of axis and 
number of groups). 
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In the bottom-left corner is displayed the status of the last action performed. The explanation of 
this command will be given later. In the bottom-right corner additional information about the 
connection is given: ONLINE or OFFLINE. 

 2.3.AXIS profile 

By selecting AXIS in the left tree selector, a table containing information about each axis of the 
robot will be showed. 

 

Figure 19: Axis Profile 

For each Axis, it's displayed the current position and its current status.Below the AXIS option in the 
left tree selector, you can also click on the single axis in order to perform a specific action or to 
obtain information about the axis itself. 

For each Axis, there are many available information regarding the axis state, reference or 
measured position, speed and acceleration, position scaling and movement limits. 

Below this table two folders are available: AXIS JOG and HOMING. The first must be used to 
perform a jog movement, while the second is used to set the home status of the robot. In order to 
perform these actions, you have to switch on the axis by clicking on the “SWITCH ON” button. If 
the drive has correctly been switched on, the corresponding icon 
on the left tree selector will turn green, while if there is some error, 
the icon will turn red (wenn error, check the config files and cabel 
connection). 

 2.4.Axis Jog: single Drive command profile 

In that profile dashboard, it is possible to command and set up a 
single axis (Drive), enabling it and moves back and forward, reset 
its STATE in case of error and see the setting parameters. It is 
possible also to do HOMING procedure to store the position of the 
drive to be used as zero in the controller works. 

As showed an example of jogging movement in Figure 19. The 
JOG Positive button can be being pressed: the Drive's State is in 
“JOG”. Once the drive is switched on, the other buttons will be 
available to the user. The “SWITCH OFF” button will switch off the 
drive, the “JOG Negative” and “JOG Positive” buttons will provide 

Figure 20: Axis Jog Parameter 
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a jog movement to the selected drive (positive or negative directions are established by the 
orientation of the actuator), the “GOTO” button can be used to 
specify a point in the workspace that must be reached by the robot 
with a direct movement, the “RESET” button must be used to reset 
the drive when an error occurs. 

Below this buttons the user can modify the jog setting by clicking on 
the “Jog settings” button. A new window will appear, providing the 
user the actual Jog Parameters that can be modified simply by 
clicking on them.  

If only the Jog speed must be changed, the user can modify the 
value also by acting on the slide bar “Jog speed” on the right of the 
“Jog settings” button. 

Figure 21 shows how the Go To command works: once the button 
has been clicked, the displayed window will appear. Here the user 
can set the Drive position to reach, as well as the maximum speed, 
acceleration and jerk that must be used to perform the movement. After settings the parameters, 
by clicking on the “OK” button the robot will perform the planned movement.  

 2.5.Axis’s HOMING profile 

The HOMING folder can be used to set the home position of the Drive (Figure 5.6.1). After moving 
the drive to the desired position (by using the Jog command for example), the user can click on 
the “START HOMING” button in order to take the actual position as a zero position.  

 

Figure 22:Homing parameters 

The button “Homing settings” can be used to plan how the homing 
should be performed. 

Figure 23 shows the parameters that can be modified. The selected 
method refers to the method used to set the homing procedure (the 
default value is 35, which corresponds to the Set QUOTA method). 

The homing FAST and SLOW speed refers to the speeds that the 
Drive will follow once it will be forced to the homing configuration. 
They are expressed as a percentage of the maximum speed 
achievable. 

Figure 23: Axis Homing 

Figure 21:GOTO Setting 
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The Homing acceleration can be used to set the time to accelerate from 0 to the rated motor 
speed (as explained in the window). 

 2.6.GROUPS profile 

By selecting GROUPS in the left tree selector, the user can check the group axis overview in a 
table similar to the one showed in AXIS. If one clicks on the group name the available commands 
and information for the Group will be available . 

Both information and commands are different from those specified in a single axis. In the 
information box it is showed the Group State, the Angle Mode (the convention used to describe the 
end effector orientation) which is Euler ZYZ, the position both in the ACS and in the MCS 
coordinate systems and the kinematic parameters of the robot. 

 

Figure 24: Groups profile. 

Even if the commands have the same name of the single axis commands, they have some radical 
differences. First of all, by clicking on the “Switch ON” button, each drive configured in the group 
will switch on (as you can see in Figure 24, since the group BONMET_3KG_CF is configured with 
all the six axis, after switching on the group, each axis has been switched on). In the same way, by 
clicking on “Switch OFF” each configured axis will switch off. 

The “Move Linear” button replaces the “Go To” button of the single axis: by clicking on it, the 
window showed in Figure 25 will appear and the robot will executes a MoveLinear command 
(trajectory defined in the Work Space and actuated using inverse kinematic, pay attention to 
orientation singularities that can drive the robot into error configuration). 

In this window, the user can set both the position 
and the orientation that the robot should reach. 

Maximum speed, acceleration and jerk can be set, 
just like in the single axis “Go To” command. 

Once the movement has been planned, click on 
“OK” to make the robot perform the movement. 

If during the movement at least one axis reaches a 
limit position, the movement will stop and an error 
will be set. 

In order to use again the group command, the user 
must first reset each axis that has reached an error 
state and then switch on again the group. For what 

 

Figure 25: Goups Move Linear 
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concerning the group jog movement, the “Jog settings” button and the “Jog speed” slide bar are 
still available and they work in the same way as showed in the axis jog movement. For the group 
movements, it is also possible to select if the commanded jog movement should be performed as 
a linear jog or as a rotational jog in the MCS coordinate system. If the linear jog is selected, the jog 
button will move the robot along the X,Y or Z MCS axis, while if the rotational jog is selected the 
jog will rotate the end effector around the X,Y or Z axis (Euler ZYZ convention). 

For the sake of safty and convenience, user can also firstly simulate the robot movement by using 
the 3D visualization button.As shown in Figure 26, a 6 axis robot is simulated and user can use 
the toupad or move command to perform the movement. 

 

Figure 26:Use 3D visualization to simulate the robot movement 

 2.7.Cameras Calibration Profile 

Camera Pose Calibration is a necessary process before doing detection of object and giving 
precisely object position and rotation in MCS (Machine Coordinate System). The aim of Camera 
Pose Calibration is to obtain the camera position and rotation in MCS. Then it will be possible to 
transform the object position from the coordinates in camera itself to MCS. Once a camera is 
newly installed in a robot system, a pose calibration is supposed to be processed. 

The pose calibration can be processed in variable ways, in our vision system, it is provided that a 
process based on a chessboard-based (or pattern-based) in order to facilitate the operation. 

Here are the prerequisites before making pose calibration: 

• Well-calibrated internal parameters of camera. 

• A 5×8 grid standard chessboard. 

• The chessboard (or other patterns) to be detected by camera can also be reached and 
measured by one of the robots, directly or via a conveyor (e.g. A straight moving belt). 

If the chessboard has to be transferred by a conveyor, the positive direction of belt in MCS is 
supposed to be known.The pose calibration can be processed by using our GUI (Graphical User 
Interface). 

 a)Camera calibration 

The vision system of our controller supports the use of IFM O2D222 camera. The controller makes 
communication with the camera via TCP/IP protocol. The IFM O2D222 camera provides the 
function of object detection which is remotely processed in the camera and sends results and 
image to our controller via TCP/IP. 

http://www.ifm.com/products/us/ds/O2D222.htm
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IFM provides some software and documentations. Here is the list of necessary resources to be 
referred to in this document: 

• The operating software (http://www.ifm.com/ifmus/web/dualis-download.htm) 

• The installation guide (http://www.ifm.com/mounting/706370UK.pdf) 

• The programming manual (http://www.ifm.com/mounting/704420UK.pdf) 

The setup of hardware is independent to our controller. Thus please refer to the installation guide. 

Before the using of camera, it is necessary to correctly setup the camera application depending on 
the specific task. The application setup is via the official operating software provided by IFM of 
which the downloading link can be found on website: 

After downloading and installation, the first step is to connect the camera that is supposed to be 
correctly setup. 

 

Figure 27: setup the camera calibration 

• 1. From menu Connections/ IP address…., 
• 2. Open the interface of connection. The input fields for the IP address appear. 
• 3. Enter “IP address” 
• 4. Click on “Connect” 

The factory setting of network parameters is: 

 

Figure 28: the factory setting of network 

If the factory setting has been modified, the network parameters can be found and modified 
directly on device.(refer to Section 5.3.6 in the programming manual) 

• After successful connection, click on “applications” 

• In field 2, the application can be modified. 

• In field 3, there are some global administrations. In tabs “General” and “Network parameters”, 
the settings can be as the user-defined depending on working environment. 

http://www.ifm.com/ifmus/web/dualis-download.htm
http://www.ifm.com/mounting/706370UK.pdf
http://www.ifm.com/mounting/704420UK.pdf
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Figure 29: Application settings 

In tab “Global sensor settings”, the settings must be as following. 

 

Figure 30:Global sensor setting 

In tab “Process interface”, the settings must be as following. 

 

Figure 31:Process interface setting 

After that, create new applications: 

 

Figure 32: Procedure to create new applications 

1. Select the folder 1 
2. Click on “New”  
3. The pop-up window “New application” opens. 
4. Enter the name of the application 
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5. Click on “OK” 

The steps of setting application should follow: 
• Image quality 
• Model definition 
• Process Interface 
• Trigger configuration 
• Function test 

The procedure of steps can refer to the official installation guide on section 8.7 – 8.13 in the 
installation guide. In particular, to match the camera diver in our controller, the TCP/IP definition 
must be set as following: 

 

Figure 33:TCP/IP setting 

 b)Connection 

User need use a network switch (or Router) to connect the robot controller, camera with the PC. A 
Ethernet cable is used for the connection from PC to network switch and another two Eternet 
cable are needed to connect the router with the robot controller and the camera. 

 c)Start Window 

In the camera profile, after “enable”, click on “Pose Calibration” to start the procedure. 

Figure 34: startup the camera settings 
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 d)Basic Interfaces 

 

Figure 35: camera calibration 

The list of steps is shown in field 1 indicating the current steps. In field 2, it shows the image 
caught by camera. In field 3, it shows the tips instructing what the user should do in current step. 
In field 4, it shows the information of calibration, the results of each step and final calibration 
results. In field 5, the operations can be done here depending on each step. 

i. Fetch Pattern 

On first step, once the chessboard is put under the camera, click on “Fetch” to trigger camera 
scanning the image to find chessboard. If the fetching is successful, the chessboard will be 
marked some points as anchors which need to be measured in future steps. And click on “Next” to 
continue. If failed, please check the image if the chessboard is properly put under the camera so 
that the camera can see every corners. If all of corners can be seen, please check if the 
chessboard is standard as 5×8 grid or if the lighting condition is good enough to recognize it. 

 

Figure 36: Fetch Pattern 
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ii. Move belt 

 

Figure 37: Move Belt 

In step 2, the mission is to select a belt axis if it exists. If there is no belt, select “None” and click 
on “Confirm”. Then this step can be skipped and belt movement will not be considered. 

If a belt is setup, please select the axis of belt and fulfill the belt direction. Put in belt direction 
according to robot coordinate system. For example, if belt is move along to negative direction of x 
axis then input value should be x = -1, y = 0. 

Then click on “Confirm” to confirm the selection. If the selection has mistakes, click on “Reset” to 
remove selection, then make a new selection of belt. After successful belt selection, please move 
the belt to transfer chessboard on the proper position in which the robot can measure all of 
marked anchor points. Then click on “Move Done” to record the belt moving offset. If the position is 
not good enough, the “Move Done” can be re-clicked on to update the belt position. 

iii. Measure 

In this step, select, first of all, and confirm a robot used to do measurement. 

 

Figure 38: Measure 

Then, select a point (point 0 to red 0, point 1 to red 1…) in the list and measure it. Once the 

TCP is moved closely enough to the target point. Click on “Sample Anchors” to record the position 
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of current point. The point can be re-measured to update data until each point is satisfied. 

After sampling all of points, click “Next” to continue. 

iv. Compute 

In this step, click on “Compute” to get calibration results. 

 

Figure 39:Compute 

Two evaluation values are provided to evaluate the results 
• Shape Compensation Error 

• The Projection Error 

Shape Compensation Error is the value deviation generated when making rectification of point 
shape. The value is suggested not larger than 10%. 

The Projection Error is the average deviation between projection point and real measured point. 
The value is suggested not larger than 1%.Update Configuration 

If the calibration result is satisfied, the last step is to update configuration file. The new calibrated 
translation and rotation of camera pose will be written in vision configuration file and cover the old 
values. 

 

Figure 40: update the vision configuration files 
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 2.8.CNC profile 

The CNC profile is used to move the robot through many points collected directly from the 
workspace. After selecting the “GUI” controller Authority from the BMC profile, the user can select 
the CNC profile to access to this functionality. 

As showed in figure 41, in the CNC profile, there are two main buttons: the “Refresh” button is 
used to refresh the main page, while the “New project” button can be used to create a new CNC 
project. 

Besides those two buttons, there is a table that describes the current CNC project and its files. In 
the example, a empty “NewProject0” project has been created. 

 

Figure 41: main CNC profile 

From this window is both possible to add a new CNC program file (by right-clicking on the table 
and selecting “New Program”) and to edit one of the already created files (by double clicking on 
the file name). 

After opening the file, a new window will appear with two main fields under the tool bar: 
“PROGRAM” and “DATA”. 

The selection of the workspace point is performed in “DATA”: after moving the robot manipulator to 
the desired point (for example by using the Jog movements), it is possible to collect the 
coordinates of the reached point by clicking on “Teach” (Figure 42). 
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Figure 42: JOG the robot movement and collect the points using “Teach” 

In the showed example of figure 42, Three points has been collected: Ax0, Ax1, and Ax2 by using 
“AddPos” button. After collecting these points, in the “PROGRAM” field, User can use them to 
program the movement. Or more easily, using “AddMove” command to notice the point and 
program it together.  

In this example, for each collected point in “DATA”, a corresponding text lines has been written in 
the “PROGRAM” field: “PTP(Ax0)” will command to the robot to move from the actual workspace 
point to the collected point “Ax0”, “PTP(Ax1)” will command the movement to “Ax1” and so on.  

 

Figure 43:CNC Programm 

In the “PROGRAM” field the user can implement also many commands of the C programming 
language, like FOR or WHILE cycles and IF or CASE selector. 

The “Font” provides many option to change the font type and format. 
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After writing the program, it can be tested with the tool bar command. First of all, click on the “Set” 
button to enable the written program to be tested (only one program can be run at the same time). 
The status showed in the bottom part of the window will change to “READY”. After that, the 
“Continue” and “Step” command will become available. 

Click on the “Continue” button to run continuously the written program. Click on the “Step” button 
to run only one line of the written program instead. Click on the “Restart” button to restart the 
program. 

By clicking on “Unset”, the current program won't be enabled anymore. In this way the user will be 
allowed for example to modify the program before testing it again. 
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 3.Controller configuration files: ECAT 

The “ECAT_Config” file contains the references and the setup parameters to initialize the 
communication between the Controller and the slaves (the Drives) and make the system working. 

In that chapter the configuration file named “ECAT_Config” will be explained. In particular, the 
procedure to generate the EtherCAT configuration for 6 Axis Servodrive is presented in such a way 
to made the User able to create the ECAT (ENI) file corresponding to its own Drives configuration. 

 3.1.Software Requirements 

TwinCAT 2 NC installed on the PC 

Single Axis Servodrive: 

BonMET SSx4 series XML installed in the TwinCAT folder (C:\TwinCAT\Io\EtherCAT) 

4/6 Axis Servodrive: 

Scramp 6_Axis XML XML installed in the TwinCAT folder (C:\TwinCAT\Io\EtherCAT) 

 3.2.Procedure to generate ENI files for Single Axis Servodrive 

The following procedure describe how to create the ENI file for the configuration of the robotic 
controller. Start TwinCAT system manager; click on Edit > New 

 

Figure 44: add a new EtherCAT file 

On I/O devices right click and select “Append Device”; select EtherCAT > EtherCAT and press OK 

 

Figure 45: select EtherCAT device 
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Rename the new device as “Master” (either by selecting on the tree and pressing F2 key or 
selecting the General TAB and change the Name box) 

 

Figure 46: Append box to EtherCAT device 

Right click on “Master” and select “Append Box”; choose BonMET SSx4 drive and press OK; when 
prompted on adding NC configuration press “yes”. 

 

Figure 47: add BonMET SSx4 file 
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Figure 48: set cycle time as 1 ms 

Change the box name as “Drive1”. Repeat appending box to include as many drives as required 
by the application (6 drives are configured in this example). Rename each axis to reflect axis 
function (this name will be used in the motion configuration file to refer to the axis). 

 

Figure 49: add as many axes as required 

Select NC-Configuration > NC-Task 1 SAF and set the interpolation time (1ms). 

Finally, save Twincat configuration (File > Save As), and select EtherCAT master and EtherCAT 
tab 
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Figure 50: export EtherCAT_Config file 

Click on Export configuration file and save XML file; rename to ECAT_DefaultConfig.xml and copy 
to the robotic controller. 

 3.3.Procedure to generate ENI files for 4/6 Axis Servodrive 

The following procedure describes how to create the ENI file for the configuration of the robotic 
controller. 

Start TwinCAT system manager; click on Edit > New 

 

Figure 51:open the Twincat window 

Right click on I/O device and select “Append Device”; select EtherCAT > EtherCAT and press OK 
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Figure 52: Append Device  

 

Figure 53: Select EtherCAT/EtherCAT 

If no device is connected to the PC, a window will appear, click cancel to skip. 

 

Figure 54: Click cancel to skip this step 

Rename the new device as “Master” (either by selecting on the tree and pressing F2 key or 
selecting the General TAB and change the Name box) 
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Figure 55: Rename the device as “Master” 

Right click on “Master” and select “Append Box”; choose Scramp robotics GmbH/6Axis – 
interpolated position mode and press OK; when prompted on adding NC configuration press “yes”. 

 

Figure 56: insert device to master 

Rename the appended device as 6AX, which keeps the same as Mition_Config.xml (explained in 
next chapter). Set the NC task with a Cycle ticks 1 ms. 
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Figure 57: Rename the appended box and set NC task 

Repeat appending box to include as many Servodrives as required by the application (in the 
example only one 6 Axis Servodrive is used.) If more Serodrives are needed for the application, 
repeat that steps and rename each box as it in Motion_Config.xml. 

Append 6 Axis to the “6AX” Box and Rename the appended NC axes as you wish to reflect axis 
function (not that name will be used in the motion configuration file). 

 

Figure 58: Append 6 Axis to the “6AX” and rename them 

Select EtherCAT “Master” and the EtherCAT tab in the right window.Click on Export configuration 
file and save XML file; rename to ECAT_DefaultConfig.xml and upload to the robotic controller. 
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Figure 59: Export xml file for robot controller 

Once the User ends the procedure to generate the configuration file for the communication 
between Robotic Controller and drives, load it to the robot controller and open GUI / Ethercat, the 
status will show ECAT_OP. It must pay attention to the names used in the MOTION_Config.xml 
file: they must be equal to the names used in the ECAT_Config.xml, otherwise the controller 
cannot enable the axis, even the link is successful established. 

 

Figure 60: Check the link state 
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 4.Controller configuration files: MOTION 

 4.1.XML file structure 

The motion configuration file is written in Extensible Markup Language (XML) that is a markup 
language that defines a set of rules for encoding documents in a format which is both human-
readable and machine-readable. 

Inside the robotic controller, the “MOTION_DefaultConfig.xml” file represent the user set up for the 
robot control: it contains information about the axis configured, composing the actuation part of the 
robot, about both kinematic and dynamic description of the robot in use, and other information, 
such as Work Space speed, acceleration and jerk limits, offset and translation before and after the 
robot structure and so on. 

In the following, the purpose of the MOTION_DefaultConfig.xml file will be explained, dividing the 
task in two macro sections: Drive and AxesGroup. It should be noted that only the needed 
parameter are used (written) in xml files. The following table explains the meaning of parameters 
used in the example. 

 4.2.Drive List  

The following Table reports an example of the structure of a “DRIVE” element of the Drive List, 
with all the parameters to be configured: 

<Drive> 

<Name>AX1</Name> 

<Type>COE402_EL</Type> 

<Links> 

<SW>6AX.TxPdo_0.SW1</SW> 

<PAV>6AX.TxPdo_0.PAV1</PAV> 

<VAV>6AX.TxPdo_0.VAV1</VAV> 

<TAV>6AX.TxPdo_0.TAV1</TAV> 

<CW>6AX.RxPdo_0.CW1</CW> 

<TPOS>6AX.RxPdo_0.TPOS1</TPOS> 

<VOFS>6AX.RxPdo_0.VOFS1</VOFS> 

<TOFS>6AX.RxPdo_0.TOFS1</TOFS> 

<OD_Offset>#x000</OD_Offset> 

</Links> 

<EncResolution>131072</EncResolution> 

<GearRatioNum>121</GearRatioNum> 

<GearRatioDen>1</GearRatioDen> 

<PosScalingNum>360.0</PosScalingNum> 

<PosScalingDen>1.0</PosScalingDen> 

<SpeedScalingRatio>1.0</SpeedScalingRatio> 

<AccelScalingRatio>1.0</AccelScalingRatio> 

<PosInversion>FALSE</PosInversion> 

<PosLimitEnable>TRUE</PosLimitEnable> 

<PosLowerLimit>-170.0</PosLowerLimit> 

<PosUpperLimit>+170.0</PosUpperLimit> 

<MotorNominalTorque>0.64</MotorNominalTorque> 

<MaxSpeed>140.0</MaxSpeed> 

<ReducedSpeedPerc>100.0</ReducedSpeedPerc> 

<MaxAccel>1400.0</MaxAccel> 
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<MaxDecel>1400.0</MaxDecel> 

<MaxJerk>14000.0</MaxJerk> 

<HomingMethod>35</HomingMethod> 

<HomeOffset>0.0</HomeOffset> 

<HomingSwitchSpeedPerc>10.0</HomingSwitchSpeedPerc> 

<HomingIndexSpeedPerc>5.0</HomingIndexSpeedPerc> 

<HomingAccelPerc>10.0</HomingAccelPerc> 

<HomingTimeoutMs>30000</HomingTimeoutMs> 

<UseAbsValid_Sw15>1</UseAbsValid_Sw15> 

</Drive> 

All the elements contained inside the command <Drive> and </Drive> are referred to one axis, the 
following table explain the parameters to be used: 

Parameters Description Type 
Value 

(EXAMPLE) 

Name 
Name of the Drive: must be consistent to the 
one reported in the ECAT_DefaultConfig.xml 

file 
char AX1 

Type 

Tells the controller if the axis is real (COE for 
Single axis Servodrive /COE402_EL for 6 

axis Servodrive) or it is simulated internally 
(VIRTUAL). A simulated axis doesn’t act any 

communication with the drive 

AxisType COE402_EL 

Links 

Declared the TxPdo and RxPdo address of each axis, which is 
configured in 4/6 axis Servodrive. 

(Only used for 4/6 axis Servodrive) 

EncResolution Encoder resolution in a drive revolution int32 131072 

GearRatioNum Gearbox parameter: motor revolution in32 121 

GearRatioDen Gearbox parameter: load revolution int32 1 

RotorInertia 
Inertia of the motor rotor before gear 

redactor 
double 0.0035e-4 

AxisStructure 
Tells if the axis must be considered as linear 

(i.e. displacement in meters), or revolute 
(default option). 

AxisStruct 

(PRISM, 
REV) 

PRISM 

PosScalingNum 
Scaling of the position after the gearbox, 

position units 
double 360.0 

PosScalingDen Scaling of the position: load revolution int32 1.0 

SpeedScalingRatio 
increments/second times drive velocity 

unitary value 
double 1.0 

AccelScalingRatio 
increments/second^2 times drive 

acceleration unitary value 
double 1.0 

PosInversion 
Invert the position given to the drive from the 

controller and vice versa 
uint8 FALSE 
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PosLimitEnable Enable the usage of joint limits uint8 TRUE 

PosUpperLimit Upper limit of the joint after gearbox double +170.0 

PosLowerLimit Lower limit of the joint after gearbox double -170.0 

MotorNominalTorque 
Nominal torque of the motor actuating the 

joint 
double 0.318 

MaxSpeed 

Maximum speed the joint can achieve after 
the gearbox, 

units/second 

double 140.0 

ReducedSpeedPerc Percentage of maximum speed to be used double 100.0 

MaxAccel 

Maximum acceleration the joint can achieve 
after the gearbox, 

units/second^2 

double 1400.0 

MaxDecel 

Maximum deceleration the joint can achieve 
after the gearbox, 

unit/second^2 

double 1400.0 

MaxJerk 

Maximum jerk the joint can achieve after the 
gearbox, 

unit/second^3 

double 14000.0 

HomingMethod 
Homing method necessary to set a new zero 
position for the axis (CANopen specification) 

uint8 35 

HomeOffset 
Units offset that can be added to the homing 

position set up 
double 0.0 

HomingSwitchSpeed
Perc 

Percentage of the MaxSpeed to be used in 
the homing procedure 

double 10.0 

HomingIndexSpeedP
erc 

Percentage of the MaxSpeed to be used in 
the homing procedure 

double 5.0 

HomingAccelPerc 
Percentage of the MaxAccel to be used in 

the homing procedure 
double 10.0 

HomingTimeoutMs 
Time to complete the homing procedure in 

millisecond 
uint32 30000 

UseAbsValid_Sw15 - - 1 

It is important to remark that the name of the drive must be the same of the correspondent section 
of the “ECAT_DefaultConfig.xml” file, otherwise the communication cannot be set up. It should 
also be noted that the order of each drive is important for PLC program and can’t be changed 
unreasonable. 
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To use a virtualization of the axis, without any real actuation of commands outside the controller, 
the Type field must be fitted with “VIRTUAL” instead “COE402_EL” that represent the command 
for real axis actuation. 

The PosInversion parameters must be correctly set up on the base of the indication regarding the 
robot kinematics in use, in case of a group of axis. A wrong value can lead to an error and 
unwanted movement of the mechanism. 
  

Figure 61: Motor model with gear 
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 4.3.AxesGroup List 

Firstly, one example is used here to depict the structure of the AxesGroup List. 

<AxesGroupList> 

      <AxesGroup> 

        <Name>BONMET_3KG_CF</Name> 

        <Kinematic> 

          <KinType>Anthrop6_Cf</KinType> 

          <DriveNameList> 

            <DriveName>AX1</DriveName> 

            <DriveName>AX2</DriveName> 

            <DriveName>AX3</DriveName> 

            <DriveName>AX4</DriveName> 

            <DriveName>AX5</DriveName> 

            <DriveName>AX6</DriveName> 

          </DriveNameList> 

          <Params> 

            <L1>0.32</L1> 

            <L2>0.270</L2> 

            <L2b>0.00</L2b> 

            <L3>0.07</L3> 

            <L4>0.299</L4> 

            <L5>0.0785</L5> 

            <L6>0.050</L6> 

            <L7>0.00</L7> 

             

            <b1>0</b1> 

            <b2>0</b2> 

            <b3>0</b3> 

            <b4>0</b4> 

            <b5>0</b5> 

            <b6>0</b6> 

            <f1>0</f1> 

            <f2>0</f2> 

            <f3>0</f3> 

            <f4>0</f4> 

            <f5>0</f5> 

            <f6>0</f6> 

            <f_w0_1>0.002</f_w0_1> 

            <f_w0_2>0.002</f_w0_2> 

            <f_w0_3>0.002</f_w0_3> 

            <f_w0_4>0.002</f_w0_4> 

            <f_w0_5>0.002</f_w0_5> 

            <f_w0_6>0.002</f_w0_6> 

             

            <m2>0</m2> 

            <m3>0</m3> 

            <m4>0</m4> 

            <m5>0</m5> 
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            <m6>0</m6> 

             

            <r2x>0</r2x> 

            <r2y>0</r2y> 

            <r3x>0</r3x> 

            <r4x>0</r4x> 

            <r4z>0</r4z> 

            <r5x>0</r5x> 

            <r5y>0</r5y> 

            <r6y>0</r6y> 

            <r6z>0</r6z> 

             

            <I1yy>0</I1yy> 

            <I2zz>0</I2zz> 

            <I2xy>0</I2xy> 

            <I2yz>0</I2yz> 

            <I3xy>0</I3xy> 

            <I3xz>0</I3xz> 

            <I3yz>0</I3yz> 

            <I4yy>0</I4yy> 

            <I4xy>0</I4xy> 

            <I4xz>0</I4xz> 

            <I4yz>0</I4yz> 

            <I5xx>0</I5xx> 

            <I5yy>0</I5yy> 

            <I5xy>0</I5xy> 

            <I5xz>0</I5xz> 

            <I5yz>0</I5yz> 

            <I6xx>0</I6xx> 

            <I6yy>0</I6yy> 

            <I6zz>0</I6zz> 

            <I6xy>0</I6xy> 

            <I6xz>0</I6xz> 

            <I6yz>0</I6yz> 

          </Params> 

        </Kinematic> 

        <BaseOffset> 

          <X>0.0</X> 

          <Y>0.0</Y> 

          <Z>0.0</Z> 

          <RotA>0.0</RotA> 

          <RotB>0.0</RotB> 

          <RotC>0.0</RotC> 

        </BaseOffset> 

        <ToolOffset> 

          <X>0.0</X> 

          <Y>0.0</Y> 

          <Z>0.0</Z> 

          <RotA>0.0</RotA> 
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          <RotB>0.0</RotB> 

          <RotC>0.0</RotC> 

        </ToolOffset> 

        <AnglesMode>ZYZ</AnglesMode> 

        <MaxSpeed>0.4</MaxSpeed> 

        <MaxAccel>4</MaxAccel> 

        <MaxJerk>40</MaxJerk> 

      </AxesGroup> 

    </AxesGroupList> 

  </Config> 

</MotionConfig> 

This section contains the AxesGroups formed by the user, grouping all or some of the Drive 
initialized in the DriveList section. The section is encoded with the command <AxesGroup> and 
</AxesGroup> and can also contain nothing but the identification of the list must be present. 

The main parameters of a single AxesGroup are the name and the kind of robot structure used, 
the list of drives composing the group and the kinematic parameters of the mechanical structure. 

Parameters Description Type Value 

Name Name of the AxesGroup char 
BONMET
_3KG_CF 

Kinematic 
Structure containing all the user defined parameters of a 
robot, such as drive list composing the actuation part of 

the robot, geometric parameters and dynamic ones. 
structure ** 

BaseOffset 

Rotor-translation that can be applied to the base of the 
robot (BEFORE the kinematic structure), composed by: 

Linear displacement (X,Y,Z) 

Rotation around main axes (A,B,C) 

structure * 

ToolOffset 

Rotor-translation that can be applied to the end of the 
robot (describing for example the TOOL/END EFFECTOR 
dimensions, AFTER the robot kinematic), composed by: 

Linear displacement (X,Y,Z) 

Rotation around main axes (A,B,C) 

structure * 

MaxSpeed 
Maximum Work Space speed of the tool/End Effector 

[m/s] (Formel) 
double 1.0 

MaxAccel 
Maximum Work Space acceleration of the tool/End 

Effector [m/s^2] 
double 10.0 

MaxJerk 
Maximum Work Space jerk of the tool/End Effector 

[m/s^3] 
double 100.0 

AnglesMode 
Representation of the angles A,B,C to be used: can be 

Euler (ZYZ) or Roll, Pitch and Yaw (RPY) 
char ZYZ 

Coupling 
Coupling matrix that allow to decouple via software the 
joint movement and solve the kinematic. It is a square 

matrix with dimension the number of joints. 
matrix * 
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* are depicted in Figure 54 

** see chapter 4.6 

 

Figure 62: Structure of BaseOffset, ToolOffset and Coupling 

The above Table reports the main sections and parameters of a typical AxesGroup, then in the 
following specific example, each kinematics AxesGroup will be reported. 

The Kinematic structure contains different kind of parameters on the base of the robot structure 
that are used, in the following the supported Kinematic structures will be explained and presented 
with examples about the configuration parameters. 

 4.4.AnglesMode 

Rotation matrices, which give the representation of the orientation in the Work Space (Cartesian 
space of work) are composed by nine elements, which are computed starting from two possible 
rotation conventions to represent the three angles that represent orientation: Euler or Roll, Pitch 
and Yaw. 

 a)Euler angles 

A representation of orientation in terms of three independent parameters constitutes a so-called 
minimal representation that can be obtained using a set if three angles Φ=[φ, ϑ, ψ]. 

The rotation described by ZYZ angles is obtained as composition of elementary rotations: 

1. Rotate reference frame by angle φaround Z axis; 

2. Rotate reference frame by angle ϑaround Y axis; 

3. Rotate reference frame by angle ψaround Z axis. 

The resulting rotation composition follows in Figure 55: 

 

Figure 63: Euler ZYZ rotation angles. 
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 b)Roll, Pitch and Yaw angles 

A Euler angles-derived representation is the aeronautical well known Roll, Pitch and Yaw 
convention. That angles, named ZYX denote typically the rotations around main axis of a 
reference frame fixed on the object that must be described in orientation in the Work Space. 

The rotations resulting from Roll, Pitch and Yaw angles can be obtained as composition of the 
following elementary steps: 

1. Rotate reference frame by angle φaround Z axis (Roll) 

2. Rotate reference frame by angle ϑaround Y axis (Pitch); 

3. Rotate reference frame by angleψaround X axis (Yaw);. 

Figure 56 shows the composition of RPY (Roll, Pitch and Yaw) angles: 

 

Figure 64: Roll, Pitch and Yaw angles composition. 

 c)Example of angles representation 

Both the representations for the zero position of the anthropomorphic robot with spherical wrist 
(i.e.) present the same orientation to reach all joint to zero angular displacement: 

T = [X, Y, Z, 0.0°, -90.0°, -180.0°] 

If the user wants to orientate robot with the End-Effector parallel to the plane XY (down, in a 
pick/place position i.e.) the orientation becomes in ZYZ angles: 

T = [X, Y, Z, 0.0°, -180.0°, -180.0°] 

In that way the orientation of the wrist can be controlled using the ZYZ or RPY angles, taking into 
account that the Work Space angles ARE NOT the joint angles of the robot. 

 4.5.Coupling Matrix 

It allows the definition in the Motion Configuration file of the Coupling matrix, that made possible 
the matching and un-matching of multi axis and rotations movement regarding the same joint: i.e. 
if the wrist revolute joint actuates also a translation, it is possible, thanks to that matrix, to take into 
account of that unwanted displacement and compensate it with another joint. In that way the 
controller see always the axis decoupled one from each other’s actuating only a revolution or a 
translation. 
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The mathematical structure of the Coupling matrix is the following one, reported in the following 
Table and showing with operation the matrix actuates on the joint position array: 

 Axis 1 Axis 2 Axis 3 Axis 4 Axis 5 Axis 6 

Axis 1 =  a1*Axis1 + a2*Axis2 +  a3*Axis3 + a4*Axis4 +  a5*Axis5 + a6*Axis6 

Axis 2 = b1*Axis1 + b2*Axis2 + b3*Axis3 + b4*Axis4 + b5*Axis5 + b6*Axis6 

Axis 3 =  c1*Axis1 + c2*Axis2 + c3*Axis3 + c4*Axis4 + c5*Axis5 + c6*Axis6 

Axis 4 =  d1*Axis1 + d2*Axis2 + d3*Axis3 + d4*Axis4 + d5*Axis5 + d6*Axis6 

Axis 5 =  e1*Axis1 + e2*Axis2 + e3*Axis3 + e4*Axis4 + e5*Axis5 + e6*Axis6 

Axis 6 = f1*Axis1 +  f2*Axis2 + f3*Axis3 + f4*Axis4 + f5*Axis5 + f6*Axis6 

As it is possible to see, the coupling matrix is composed by the coefficients that allows one to get 
the decoupled angles of the kinematic structure: 

 

The matrix must be setted in the Motion configuration file, where is a field of the AxesGroup and 
wants a set of rows per each joint, with the coefficients separated by “;” or “,” character. If a 
number of configured rows less than the axis composing the AxesGroup are defined, errors will be 
returned and the kinematic is not well initialized. 

If the Coupling matrix is not defined in the configuration file, the controller will initialize it to the 
identity that means no effect of coupling on the kinematic computation. 

 4.6.AxesGroup configuration for the supported robot kinematics 

 a)Anthropomorphic Robot (6-axis) 

This robot is one of the most well-known structure and wide used. It is composed by a three-joint 
arm mechanism that act the movement along Cartesian displacement (X,Y,Z) and by a three-joint 
spherical wrist that act all the rotations in the Space (A,B,C) around the main axis on the base of 
the convention used to interpret angular movement. 

The kinematic model of that mechanism is based on the following convention: 
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Figure 65: Anthropomorphic arm parameters and joint rotation directions. 

The geometric lengths of the links needed in the computation of the Kinematic model of the robot 
are represented in Figure 57 and marked as L1-L7, they are expressed in meters [m].The joints 
named “a1-a6” are signed with the revolute directions. The pose in the figure are the one the robot 
assumes with all joints to zero position. 

There are two types of kinematic solver implemented in the controller for that kinematics, one 
recursive and the other one in closed form, this gives to the user the possibility to choose the 
dexterity of the robot (means up elbow, low wrist, and so on) or to have a standard recursive 
solver. 

Kinematic 
Table 

<Kinematic>……………. </Kinematic> 

Parameters Description Type (Values EXAMPLE) 

KinType Describe the type of kinematic in use, 
must be a default value to be interpret 
correctly by the software 

Recursive solver: 

<KinType>Anthrop6_Rec</KinType> 

Closed-form solver: 

<KinType>Anthrop6_Cf<KinType> 

DriveNameList List of drives composing the actuation 
part of the robot, must be fed with exactly 
the same name given to the 
correspondent drive in the DriveList 
section and in ECAT configuration file 

<DriveNameList> 

<DriveName>Drive1</DriveName> 

<DriveName>Drive2</DriveName> 

<DriveName>Drive3</DriveName> 

<DriveName>Drive4</DriveName> 

<DriveName>Drive5</DriveName> 

<DriveName>Drive6</DriveName> 

</DriveNameList> 

Params Description of the parameters, which is 

used to construct both kinematic and dynamic model. 
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Geometric 
parameters 

Lengths of the links reported in the Figure 
57 in [m] 

<L1>0.320</L1> 

<L2>0.270</L2> 

<L2b>0.00</L2b> 

<L3>0.070</L3> 

<L4>0.299</L4> 

<L5>0.0785</L5> 

<L6>0.05</L6> 

<L7>0.00</L7> 

Dynamic 
parameters 

Dynamic parameters needed to construct 
the Dynamic model of the robot: 

Viscous friction: relative to the joint 
[Nm*rad/s] 

Static friction: relative to the joint [Nm] 

Dynamic friction: relative to the joint 
[dimensionless] 

Masses: of each link composing the 
robot [Kg] 

Center of mass’s position: Cartesian 
position of the center of mass of each link 
(with inside the motors), along X,Y,Z [m] 

Inertia tensor’s elements: main and 
deviation terms of inertia of each link with 
respect to the axis X,Y,Z of the position of 
the center of mass. 

Viscous friction 

<b1>0.0</b1> 

to 

<b6>0.0</b6> 

Static friction 

<f1>0.0</f1> 

to 

<f6>0.0</f6> 

Dynamic friction 

<f_w0_1>0.0</f_w0_1> 

to 

<f_w0_6>0.0</f_w0_6> 

Masses 

<m1>0.0</m1> 

to 

<m6>0.0</m6> 

Center of mass’s position (e.g.) 

<r2x>0.0</r2x> 

<r2y>0.0</r2y> 

<r2z>0.0</r2z> 

Inertia tensor’s elements (e.g.) 

<I2xx>0.0</I2xx> 

<I2yy>0.0</I2yy> 

<I2zz>0.0</I2zz> 

<I2xy>0.0</I2xy> 

<I2xz>0.0</I2xz> 

<I2yz>0.0</I2yz> 
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It is important to remark that the inversion of the drives must be set up accordingly to the 
AxesGroup kinematics that the user wants to use. In the 6-axis anthropomorphic robot the 
inversions scheme is the following Table: 

Drive1 Drive2 Drive3 Drive4 Drive5 Drive6 

FALSE FALSE FALSE FALSE TRUE TRUE 
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 b)Delta (Parallel) Robot (3-axis) 

 

Figure 66: Delta robot geometrical parameters and joints rotation directions. 

The parallel robotic structure, known as Delta robot, is composed by three leg, actuated by three 
joints and two links connected to a unique moving platform. 

<Kinematic> 
Table 

<Kinematic>…………..</Kinematic> 

Parameters Description Type 

KinType Describe the type of kinematic in use, 
must be a default value to be interpret 
correctly by the software 

Closed-form solver: 

<KinType>Delta3_Cf</KinType> 

DriveNameList List of drives composing the actuation 
part of the robot, must be fed with 
exactly the same name given to the 
correspondent drive in the DriveList 
section and in ECAT configuration file 

<DriveNameList> 

<DriveName>Drive1</DriveName> 

<DriveName>Drive2</DriveName> 

<DriveName>Drive3</DriveName> 

</DriveNameList> 

Params Description of the parameters, which is 

used to construct both kinematic and dynamic model 

Geometric 
parameters 

Lengths of the links reported in the 
Figure 58 in [m] 

<LA>0.127</LA> base radius 

<LB>0.180</LB> short leg length 

<LC>0.000</LC>elbow displacement  

<LD>0.450</LD> long leg length 
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<LE>0.000</LE> tool displacement 

<LR>0.0625</LR> tool radius 

Dynamic 
parameters 

Dynamic parameters needed to 
construct the Dynamic model of the 
robot: 

Viscous friction: relative to the joint 
[dimensionless] 

Static friction: relative to the joint 
[dimensionless] 

Dynamic friction: relative to the joint 
[dimensionless] 

Masses: of each link and element 
composing the robot [Kg] 

Viscous friction 

<B>0.0</B> 

Static friction 

<F>1.36</F> 

Dynamic friction 

<F_W0>0.0</F_W0> 

Masses 

<MT>0.220</MT> 

<MR>0.287</MR> 

<ME>0.250</ME> 

<MC>0.020</MC> 

Inversion flag for the drive of the Delta robot must follow the Table to avoid unwanted movement: 

Drive1 Drive2 Drive3 

FALSE FALSE FALSE 

 c)Cartesian Robot (3-axis) 

Parallel Cartesian robot: acts movement along X,Y,Z direction with three joints, as reported in 
Figure 4.3.1: 

 

Figure 67: Cartesian robot geometrical parameter. 

In Figure 59, the parameters needed in the set-up of the Cartesian’s Axes Group are presented. 
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Kinematic 
Table 

<Kinematic>……..</Kinematic> 

Parameters Description Type 

KinType Describe the type of kinematic in 
use, must be a default value to be 
interpret correctly by the software 

Closed-form solver: 

<KinType>Cartesian</KinType> 

(Recursive only) 

DriveNameList List of drives composing the 
actuation part of the robot, must be 
fed with exactly the same name 
given to the correspondent drive in 
the DriveList section and in ECAT 
configuration file 

<DriveNameList> 

<DriveName>Drive1</DriveName> 

<DriveName>Drive2</DriveName> 

<DriveName>Drive3</DriveName> 

</DriveNameList> 

Params Description of the parameters used 
to construct both kinematic and 
dynamic model 

(Up to now only kinematic model are 
implemented) 

Geometric 
parameters 

Lengths of the links reported in the 
Figure 4.3.1 in [m] 

<LA>0..0</LA>displ. of first axis 

<LB>0..0</LB> displ. of second axis 

<LC>0.0</LC> displ. of third axis 

 d)SCARA Robot (4-axis) 

Serial robot with planar arm and rotor-translating wrist, that actuate a movement along Z axis up 
and down and control the orientation of the tool around Z axis again. 

There are three type of SCARA robot supported. The discriminant of the types is the position of 
the prismatic joint, if first, third or fourth Type are selected. 

 

Figure 68: SCARA robot generic parameters representation 

The prismatic joint can be considered as first, moving all the robot along Z axis, or in third/fourth 
position, switched with the rotational axis around Z but keeping the first and second axis as the 
planar arm actuators. 
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The kinematic is recognized automatically by the controller on the base of the position of the 
prismatic (“PRISM”) drive in the configuration file. If there are configured more than one prismatic 
axis, of course the kinematic controller will return error. 

In the following table, the parameters needed in the set-up of the Cartesian’s AxesGroup are 
presented. 

Kinematic Table <Kinematic>…..</Kinematic> 

Parameters Description Type 

KinType Describe the type of kinematic in 
use, must be a default value to 
be interpret correctly by the 
software 

Closed-form solver: 

<KinType>Scara4_Cf</KinType> 

<KinType>Scara4</KinType> 

DriveNameList List of drives composing the 
actuation part of the robot, must 
be fed with exactly the same 
name given to the 
correspondent drive in the 
DriveList section and in ECAT 
configuration file 

<DriveNameList> 

<DriveName>Drive1</DriveName> 

<DriveName>Drive2</DriveName> 

<DriveName>Drive3</DriveName> 

<DriveName>Drive4</DriveName> 

</DriveNameList> 

Params Description of the parameters, which are used to construct both 
kinematic and dynamic model 

Geometric 
parameters 

Lengths of the links reported in 
the Figure 60 in [m] 

<LA>0.300</LA> 

<LB>0.300</LB> 

<LZ>0.220</LZ> 

Dynamic 
parameters 

Dynamic parameters needed to 
construct the Dynamic model of 
the robot: 

Static friction: relative to the 
joint [dimensionless] 

Dynamic friction: relative to the 
joint [dimensionless] 

Static friction 

<f1>0.0</f1> 

to 

<f6>0.0</f6> 

Dynamic friction 

<f_w0_1>0.0</f_w0_1> 

to 

<f_w0_6>0.0</f_w0_6> 

The coupling matrix must be taken into account. The fact that the rotational joint acts in some case 
(depending on the mechanical structure of the robot) also a translation related to the rotation. It’s 
possible in that way to compensate it with the prismatic joint. 

Inversion flag for the drive of the SCARA robot must follow the Table 4.4.2 to avoid unwanted 
movement: 

Drive1 Drive2 Drive3 Drive4 

TRUE TRUE TRUE TRUE 
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 e)PALLETIZER Robot (4-axis) 

This robot has a configuration similar to the anthropomorphous robot: it is composed by a three-
joint arm mechanism that acts the movement along Cartesian coordinate (XYZ), but the wrist is 
composed only by one joint that gives an additional rotation around the Z axis.  

Thanks to its particular mechanical structure, the end effector terminal is always kept parallel to 
the X-Y plane, so the wrist can rotate only around the Z axis due to its one and only one joint.    

The kinematic model of this mechanism is based on the following convention:  

 

Figure 69: Palletizer arm parameters 

The geometric lengths of the links needed in the computation of the Kinematic model are 
represented in Figure 61 and marked as L1-L6. They are expressed in meters [m]. The pose in the 
figure shows the robot assumes with all joints to zero position. 

Unlike the anthropomorphous robot, the Palletizer can’t be assumed different configuration of the 
arm to reach the same point: the only two available configuration are defined by the fourth joint 
(the wrist joint) and differ one another about a 180° rotation along the Z axis. 

Kinematic Table <Kinematic>……</Kinematic> 

Parameters Description Type 

DriveNameList  List of drives composing the actuation 
part of the robot, must be fed with exactly 
the same name given to the 
correspondent drive in the DriveList 
section and in ECAT configuration file  

<DriveNameList> 

<DriveName>Drive1</DriveName> 

<DriveName>Drive2</DriveName> 

<DriveName>Drive3</DriveName> 

<DriveName>Drive4</DriveName> 

</DriveNameList> 
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Geometric 
parameters  

Lengths of the links reported in the Figure 
61 in [m]  

<L1>0.420</L1> 

<L2>0.90</L2> 

<L3>1.300</L3> 

<L4>1.300</L4> 

<L5>0.300</L5> 

<L6>0.300</L6> 

It is important to remark that the inversion of the drives must be set up accordingly to the 
AxesGroup kinematics that the user wants to use. In the 6-axis anthropomorphic robot the 
inversions scheme is the following table. 

Drive1 Drive2 Drive3 Drive4 

FALSE FALSE FALSE FALSE 
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 5.Controller configuration files: VISION 

As previous configuration files, the vision parameters are also configured in XML file. In XML file, 
the root tag <VisionConfig> includes the list of camera. Each element of the list is camera node of 
which the tag is <camera>. 

<Camera> 

    <Name>Camera 1 (IFM)</Name> 

    <Type>IFM</Type> 

    <Protocol>IPv4_TCP</Protocol> 

    <IP>192.168.80.100</IP> 

    <Port>50010</Port> 

    <TimeoutMs>1000</TimeoutMs> 

    <OperatingDistance>0.46</OperatingDistance> 

    <FocalLengthX>1050.233</FocalLengthX> 

    <FocalLengthY>1052.020</FocalLengthY> 

    <CenterX>348.488</CenterX> 

    <CenterY>210.551</CenterY> 

    <RadialDistortCo1>0.039</RadialDistortCo1> 

    <RadialDistortCo2>-0.790</RadialDistortCo2> 

    <ImageWidth>640</ImageWidth> 

    <ImageHeight>480</ImageHeight> 

    <ImageDepth>8</ImageDepth> 

    <ImageChannel>1</ImageChannel> 

    <PoseTranslation>-1.405414 -0.2401229 -0.02921262</PoseTranslation> 

    <PoseRotation>0.07078827 -0.01720034 0.02894594</PoseRotation> 

    <DefaultApplication>0</DefaultApplication> 

    <Application> 

      <Name>IFM_Application</Name> 

      <Algorithm>REMOTE</Algorithm> 

      <AlgorithmData> 

        <Width>5</Width> 

        <Height>8</Height> 

      </AlgorithmData> 

    </Application> 

    <Application> 

      <Name>DetectChessboard</Name> 

      <Algorithm>CHESSBOARD</Algorithm> 

      <AlgorithmData> 

        <Width>5</Width> 

        <Height>8</Height> 

      </AlgorithmData> 

    </Application> 

    <Application> 

      <Name>DetectCoins</Name> 

      <Algorithm>GHTBALL</Algorithm> 

      <AlgorithmData> 

        <TemplImageFile>Vision_Source/templ.jpg</TemplImageFile> 

        <TemplDataFile>Vision_Source/templData.xml</TemplDataFile> 

        <CannyLowThresh>50</CannyLowThresh> 
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        <CannyHighThresh>100</CannyHighThresh> 

        <MinDist>100</MinDist> 

        <Levels>360</Levels> 

        <Depths>2</Depths> 

        <MaxBufferSize>1000</MaxBufferSize> 

        <VotesThresh>20</VotesThresh> 

      </AlgorithmData> 

    </Application> 

  </Camera> 

 

 5.1.Camera List 

In each camera node, the parameters consist of basic information, communication, model 
parameters, and application information. 

Parameters Description Example 

Name Name of the Drive: must be consistent to the one 
reported in the ECAT_DefaultConfig.xml file 

Camera 1 (IFM) 

Type The camera type supported by the controller. IFM 

Protocol (optional) the communication protocol type when using the 
remote camera 

IPv4_TCP 

IP (optional) IP address when using TCP/IP protocol 192.168.80.100 

Port (optional) Port when using TCP/IP protocol 50010 

TimeoutMs Time for controller connection 1000 

OperatingDistance The distance from lens to working plane in Millimeter 
(mm) 

10,0 

FocalLengthX The Focal Length along X direction in Pixels 1050.233 

FocalLengthY The Focal Length along Y direction in Pixels 1052.020 

CenterX The center position X at sensor area in Pixels 348.488 

CenterY The center position Y at sensor area in Pixels 210.551 

RadiaDistortCo1 The coefficients 1 of radian distortion 0.039 

RadiaDistortCo2 The coefficients 2 of radian distortion -0.79 

ImageWidth Image width in Pixels 640 

ImageHeight Image Height in Pixels 480 

ImageDepth The bit number containing one channel of a  pixel 
value 

8 

ImageChannel The Channel number of one pixel, usually, 1 
representing grayscale and 3 representing color 

1 

PoseTranslation The vector of translation of camera in World 
Reference System  

-1.4 -0.24 -0.029 

PoseRotation The vector of rotation of camera in World Reference 0.07 -0.017 0.029 
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System  

DefaultApplication The default application number 0 

Application List Application Data structure See Section 5.2 

The following table will describe in detail the parameters of a camera node. 

Up to now, the support camera is described in following table 

Camera Type Communication Smart Digital I/O Color 

IFMO2D222 TCP/IP YES YES NO 

 5.2.Application List 

Each camera node contains one or more application node ( using tag <application>) describing 
the application parameters. The terminology of application here specifically refers to the 
application of object detection. 

Parameters Description Example 

Name The name of application IFM_APP 

Algorithm The Algorithm Type. The Algorithm can be set as 
REMOTE if the camera is smart and can 
processes image by itself. 

CHESSBOARD 

AlgorithmData The vector of rotation of camera in World 
Reference System  

<AlgorithmData> 

<Width>5</Width> 

<Height>8</Height> 

</AlgorithmData> 

The algorithm of application can be selected by user from the following list. The different algorithm 
types have their corresponding structure of algorithm data. 

Algorithm Type Description Data Configuration 

REMOTE 
Trigger smart camera (such as 
IFM) to process image and 
retrieve results 

The application configuration is usually 
by means of third-part software. Thus, 

the AlgorithmData can be omitted。 

CHESSBOARD Detect Regular chessboard 
The parameters include width and 
height of the chessboard in the number 
of square 

 6.Controller configuration files: HANDS 

This additional configuration file is needed only if auxiliary axes are used within the used 
application (e.g. attach a gripper to 6 Axis robot for grasp tasks). Inside the HANDS configuration 
files are defined all the parameters of the auxiliary axes, as shown in Figure 62. 
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Figure 70: Three finger Gripper Hand_Config files  

 6.1.Structure  

This table illustrated the structure of the hand configuration files. 

Type Description Value 

Chain Each motor chain used must be declared inside <Chain>…</Chain> 

 Proto Contains the type of motor used Dynamixel 

NameChain The name of Chain (used in Motion_Config.xml) G1_Chain 

 Com Declared the connection information <Com>…</Com> 

 Type Type of Connection Serial 

IfName Name of communication protocal RS485 

Device Connected device /dev/ttyUSB0 

Baudrate Communication transfer rate 1000000 

Motors Contains all of used motors <Motors>…</Motors> 

 Motor Declared the used Motor <Motor>…</Motor> 

 Name Name of Motor grip_angle 

Id ID number 1 

CalibPos The calibration position 2067 

 

Figure 71: Connection of auxiliary axes 
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 6.2.MOTION_Config additional requirement 

In order to use the auxiliary axes in the robot application, some additional fields must be included 
inside the MOTION configuration file described above.  

First of all, inside the DriveList of the MOTION configuration file, the user must add a new DRIVE 
field for each motor used inside the Chain of auxiliary axes. In the example above three auxiliary 
axes have been configured inside the HANDS configuration file (grip_angle, Root and Tip), so 
three Drive must be added inside the DriveList of the MOTION configuration file (see Figure 64).  

 

Figure 72: example of additional Drive included inside the MOTION configuration file 

In the new Drive structure, the Name, Type, Name of Chain of the motor must be specified. 
PLEASE NOTE that these informations must be the same described inside the HANDS 
configuration file! 

After that, the Auxiliary Axes List must be added inside the AxesGroupList field of the MOTION 
configuration file. In the example showed in Figure 65, the list has been added between the 
Kinematic and BaseOffset fields.  

 

Figure 73: Auxiliary Axes List 

In the Auxiliary Axes List (AuxAxesList) only the drive name (DriveName) must be inserted. The 
drive names must be the same specified above inside the Drive/Name fields.  
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 7.Trajectory Generator 

In the following chapter the main purpose of the trajectory planning and generation available on 
the controller will be explained. 

The motion of the robot can be divided into two main area: DIRECT movement, in which the 
motion is planned in the motors space (JOINT SPACE -> ACS coordinate system) and doesn’t 
take the workspace feasibility of the planned movement into account, or a LINEAR motion, 
planned in Cartesian space (real world, (X,Y,Z) SPACE -> MCS coordinate system). 

Direct Movement
• Acs Coord. System
• Joint Space (space of the motors, 

coordinates are degrees or radians)
• Direct move. Good for LARGE 

movement

Motion Definition

Linear Movement
• Mcs Coord. System
• Work (Cartesian) space (space of the 

world, application (x,y,z), 
coordinates are in meters)

• Linear move. Good for SMALL but 
very precise movement (singularity 
problem)

 

Figure 74: Motion types. 

It is preferable to use a DIRECT movement for long movement because it allow to avoid the 
singularities problem of the linear movement. The motion is planned in the space of the motors 
(degrees/radians). 

To plan a precise movement in the application space (Work Space -> Cartesian Space), the 
LINEAR movement is the one must be used, considering with the problem of singularities (handled 
in the kinematic models). 

To avoid the stop at the end of each segment of motion, blending is available in such a way it’s 
possible to reschedule of path with small modification and avoid the stop of robot before starting 
the next movement when keeping the speed wanted.  

There are several possibilities to blend movements depending on the type of the motion (direct, 
linear and combinations among them). 

 7.1.Blending two MCS movements: Linear/Circular to Linear/Circular 

To connect two movements in the Work Space (MCS), there are four possible case regarding the 
actual motion type and the next one (entering): 

• Line to Line 

• Line to Circle 

• Circle to Circle 

• Circle to Line 

An example of how the blending works is depicted in the Figure 67. 
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Figure 75: Blending between lines in MCS 

The parameter that drives and defines the blending process is the OVERLAP (defined as ovl_par 
in the formal), which is a normalized percentage of the starting and ending point of the blending on 
the length of actual and next movement.  

The value of overlap can vary from 0 to 2, where 0 means no blending and 2 means full blending 
(starting from half the current movement and ending at half of the next movement). The 
Calculation for actual and next movement as follows. 

Actual movement: overlap_actual_move := 1.0 – ((ovl_par*0.5)/2.0); 

Next movement: overlap_next_move := (ovl_par*0.5) /2.0; 

This means that using blending parameter e.g. 1.0, the attaching point on actual movement is the 
75% of the actual length, and the ending point is the 25% of the next length. The value 2.0 
(maximum allowed) means blending both actual and next at the 50% of the length. 

The blending is also possible between Circular movements and Linear or Circular Movement with 
the same concept of overlap in MCS. 

 7.2.Blending two ACS movements: Direct to Direct 

It is also possible to connect two direct movements (ACS) in such a way to avoid the stop of the 
mechanism after finishing one movement. For this, the trajectories of the motors are rescheduled, 
scaling all the path of each drive respect to the slower one, in this way the motors are 
synchronous and all starts and ends at the same time. 

The aim of the rescheduling is to guarantee constant speed for the major part of the motion, 
considering the acceleration/deceleration and jerk boundaries that define the speed profile. 

 7.3.Blending Acs/Mcs to Mcs/Acs movement: mixed blending 

To conclude the possibilities of linking movements with the Trajectory Generator system, here is 
presented also the blending between mixed type of movement: ACS to MCS and MCS to ACS. 

 a)Blending starting from ACS (Direct) movement to MCS (Linear) 

The junction among the two movements is based on the switching off the ACS motion profile and a 
polynomial curve that actuate the connection with the next Linear movement.  

The beginning of blending process is done in MCS of the arrival movement using always the 
percentage of the length of both actual and next path to schedule the attaching point. 
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Please note that the blending connection is made in MCS and can drive the robot through 
singularities positions of the orientation and kinematic. 

 b)Blending starting from MCS (Linear) movement to ACS (Direct) 

The symmetric condition to the one presented before is the scheduling of a connection between 
Linear movement to Direct movement. In this case, the motion is planned scheduling a trajectory 
in the motors reference system, passing at the specific point of the Linear path corresponding to 
the blending percentage, to ACS. 

The blending mechanism in both of two reference systems prevent the robot passing through the 
connection point between the two paths, but it is necessary to ensure the continuity at speed level 
and avoid discontinuities, which can be dangerous and even damage the system. 

The method following the PLCopen standards, the following combination of transition parameters 
and blending type are actually implemented and allowable. 

 c)Transition mode: MC_TRANSITION_MODE 

TRANSITION MODE PARAMETER STATUS 

tmNone None available 

tmStartVelocity 
Keep the velocity used at the end of the first 

movement 
not available 

tmConstantVelocity Keep a constant velocity not available 

tmCornerDistance Distance from the corner on the path not available 

tmMaxCornerDeviation 
Distance from the curve computed to the 

corner 
not available 

tmRelativeCornerDistance Percentage of the overlap on the total length 
of the path to be blended 

available 
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 8.Function Blocks of PLC Vision System  

 a)Vision_CameraBuild 

Vision_CameraBuild Enable a configured camera 

Inputs Enable Enable camera at rising edge or Disable camera at falling edage 

Camera ID Camera Identification 

Outputs Status Effective state of camera 

Error The error signal 

Error ID Error identification 

 b)Vision_SetApplication 

Vision_SetApplication Configure application to camera 

Inputs Execute Start setting at the rising edge 

Camera ID Camera Identification 

Application Application Number 

Outputs Done Setting completed 

Busy Setting in process 

Error The error signal 

Error ID Error identification 

 c)Vision_ObjectDetection 

Vision_ObjectDetection Trigger Camera for object detection 

Inputs Execute Start setting at the rising edge 

Camera ID Camera Identification 

Periodic Detect in periodic or not 

DelayMs Delay in millesecond between two detections 

MatchThreshold The objects in two continuous frame will be probably 
identified as the same one. 

Outputs Done Detection completed 

Busy Detection in process 

TimeStamp The triggering time instance in microseconds 

ObjectNumber Detected object number 

Error The error signal 

Error ID Error identification 

If the “Periodic” input of the Vision_ObjectDetection function block is set to TRUE, the detect 
trigger will be set periodically according to the value of the “DelayMs” input. The suggested value 
for this input is 250 ms (minimum time), because in this way the total time between two trigger will 
be reduced. 

To compute a correct value to be set as “MatchThreshold” input, the user must consider both the 
total time between two trigger events and if the object has being moved on a conveyor belt or 
similar device. The “MatchThreshold” value is used to consider the distance between the objects 
detected in two consecutive frames, and in particular is used to discriminate whether the detected 
object are the same object (moved according to a conveyor belt or similar device) or two different 
objects. 

The total time between two trigger events is computed as the sum of the camera evaluation time 
and the delay between two detections (“DelayMs” input). The camera evaluation time should be 
provided by the camera data sheet or by the user manual: the IFM camera user manual provide as 
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typical values of evaluation time 50-800 ms. However this evaluation time depends on many 
factors, like the object size and orientation, the number of object detected, the smoothing degree 
and so on. 

To evaluate the distance between two frames, a correspondence between the camera field of view 
measured in meters and the same field of view measured in pixel is needed. The sensor reference 
manual should provide all the data needed for the computation: as an example, the user manual of 
the IFM camera provide these tables, in which the camera view field of has been related to the 
camera operating distance for different type of cameras. 

 

Figure 76: camera view field 

 d)MatchThreshold computation example 

Let’s suppose to have a conveyor belt transporting the object to be detected at a constant speed 
of 0.05 m/s (BeltSpeed = BS =0.05 m/s). 

Suppose to have installed a O2D222 camera at 300 mm from the conveyor belt from the tables 
above. the camera view field can be interpolated as 198x141 mm (0.198x0.141 m). Since the field 
of view is about 640x480 pixels, we can obtain the pixel to meter ratio (PxToM) as:  

PxToM = 640 / 0.198 = 3232 pixel/m  

The total time between two frames (TotalTime) can be computed as   

TotalTime = DelayMs + Max suggested evaluation time = 0.250 + 0.800 = 1.05 s  

For the computation we have considered the maximum value between the indicated typical values 
of the evaluation time. If the “Periodic” input is set to FALSE, the total time must be computed by 
considering the time interval between two trigger events set by the user. 

Finally the match threshold (MatchThreshold) can be computed as: 

MatchThreshold = BS * TotalTime * PxToM = 0.05 * 1.05 * 3232 = 170 pixel 

Since this value is characterized by many measurements uncertainty (like the evaluation type, as 
mentioned above), it could be useful to use a bigger value as a “MatchThreshold” input to the 
Vision_ObjectDetection (like 200 pixel). 
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 e)Vision_ReadCameraStatus 

Vision_ReadCameraStatus Return the camera state 

Inputs 
Enable Get data continuously while enabled 

Camera ID Camera Identification 

Outputs 

Valid True if valid outputs available 

Disconnect in Disconnect state while true 

Idle in Idle state while true 

ReleaseThread in ReleaseThread state while true 

Busy in Busy state while true 

ErrorState in Error state while true 

Error The error signal 

ErrorID Error identification 

 f)Vision_Reset 

Vision_Reset  Reset camera as disconnect when error occuring 

Inputs Execute Start reset at the rising edge 

Camera ID Camera identification 

Outputs Done Reset completed 

Busy Reset in process 

Error Error signal 

Error ID Error identification 

 g)Vision_ReadObject 

Vision_ReadObject Return information of object in current object queue 

Inputs Enable Get the object data of continuously while enabled 

Camera ID Camera Identification 

Object ID Object Identification 

Outputs Valid  

TimeStampUs  The instance in which the object is considered as detected 

Position The position of object in MCS 

Velocity The velocity of object in MCS 

Error Error signal 

Error ID Error Identification 

 h)Vision_ReadObjectQueue 

Vision_ReadObjectQueue Update the object id list queue and return the detected object 
number 

Inputs Enable Get data in object queue continuously while enabled 

CameraID Camera identification 

ObjectIdList The point to object list array 

ListMaxSize The maximum size of object list array 

Outputs ObjectNumber The current number of detected object in the queue 

 


